




　　 

We started with a passion for digital creation and a goal 

to make tools for makers and designers that are easy-to-

use and affordable. After almost 2,500 backers helped 

us successfully raised $1.6M on Kickstar ter, it took us 

a year to take FLUX Delta from prototype to a product 

embraced by users around the world. Our users loved 

the laser cut ter on the FLUX Delta, since it enabled 

them to cut and engrave materials beyond plastic, and 

wanted more. In fact, one of the most frequent requests 

we received from our supporters was to make the laser 

engraving module more power ful. Our team plunged 

deeper into the world of laser technology and decided 

to take on this challenge. We gained substantial expe-

r ience in manufacturing when we made a 3D printer 

from scratch. Now, in pursuit of the same goal we’ve 

had since day one, we’re leveraging our experience from 

FLUX Delta to make something just as fantastic. Beam-

box is the laser cutter and engraver that you’ve been 

waiting for, it is intuitive, intelligent, and accessible.

FLUX Team

September, 2019
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 CO2 LASER BASICS
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2.1 Before You Start
Read the following safety precautions carefully before 
operating Beambox. Beambox produces high-powered 
laser beam. Improper handling can result in fire, visual 
impairment, skin burns, or inhalation of toxic substances 
and other personal safety hazards.

Important Precautions

1 Never leave the machine unattended while operating.

2 Be sure to prepare a fire extinguisher in the work area.

3 Do not try to service, repair, or modify the machine   

without authorization from FLUX Support. 

4 Do not stare at the flame generated by the laser.

5 Please make sure that the processed material does not 

pose a hazard when burned at high temperatures.

 UNBOXING
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User Safety

1 All personnel who will operate the machine shoud read 
the safety precautions and follow the instructions. Confirm 

with FLUX Support if you have any questions regarding use 

and safety. support@flux3dp.com 

2 Children require the supervision and assistance of an 

adult at all times.

Operating Environment

1 Place the machine in a well-ventilated area.

2 Avoid rain, moisture, liquids or direct sunlight.

3 The ambient temperature and humidity should be 

within 5°C - 35°C (41°F - 95°F), 10% - 75%.

4 If venting outdoors, ensure that changing conditions 

do not cause extreme temperatures or humidity to enter 

the machine through the vent hose. Disconnect the hose 

from the outside air when the machine is not in use.

5 Place the machine on a stable surface to prevent 

overturning.
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Electrical Safety

1 The machine comes in 2 models, 110V and 220V. Do  

not use a power source other than the AC rated voltage. 

If in doubt, contact FLUX Support. (110V: 100 - 127V / 

220V: 200 - 240V)

2 Make sure that the grounding pin is properly plugged-

in. If not grounded properly, static electricity might be 

generated to affect the performance and even increase 

the risk of electric shock.

3 Do not continue to use the power cord if it is found to 

be damaged.

4 When maintaining or disassembling the machine with  

the consent of FLUX Support, be sure to turn off the pow-

er and unplug the unit.

Fire Safety

1 Do not put anything inside the machine that is not la-

ser-compatible. Learn more about laser-compatible mate-

rials (p.41). 

2 Do not stack materials; for example attempting to cut 

two or more sheets of material at a time.
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3 Clean out leftover bits inside the unit when it builds 

up.

4 Never leave the unit unattended while operating 

always stay within sight. Look inside frequently.

5 If there is a lasting flame inside the unit that does not 

extinguish when the laser has moved past. Turn off the 

machine and pull the plug on the back of the unit.

6 If it is safe to do so, extinguish the fire with a wet 

towel. Note that water may damage the machine.

7 Extinguish the fire with a fire extinguisher. Note that 

fire extinguishers may cause damage to the machine.

8 If the fire cannot be extinguished or if it spreads 

outside the machine, call your local emergency number

Smoke and Fume Safety

1 When exhausting outdoors, be sure that the exhaust 

location won’t be bothersome to neighbors or passers-by, 

and don’t forget to check local air quality regulations that 

may apply.

2 If a strong, sharp smell that also causes eyes, nose, 

or throat irritation, is detected, or visible smoke escaping  

while the lid is closed, stop immediately and re-check your 

exhaust setup.
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Operation Safety

1 Do not stare at the flame generated by the laser.

2 Stabilize the unit to prevent performance failure.

3 In case of burn injury, seek medical advice. 

4 Wear gloves when cleaning leftover bits. 

5  Have two people lif t the unit when moving the 

machine.

Safety Switch 

1 The safety interlock switche on the front door  

turn off the laser immediately if they are opened. Do 

not try to defeat the switches.

2 Keep body parts out of the workarea to prevent 

injuries. 

3 Make sure the front door is closed when adjust-

ing the optical path. 
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Stop Using Your Beambox If...

1 There is a fire in the unit which persists after the 

laser turns off.

2 The head stops moving but the laser is on.

3 An unusual sound or unusual light coming from 

the unit that was not occurring previously.

4 You see any damage to the interior components 

of  the unit.

 

Now, let's get started!
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2.2 What's In The Box
1 Place the box on the floor and unseal the box.

2 Remove the cushions on the four corners and  
      take out the machine. Have two people lift the  
      unit out of the box. Keep the packaging in case  
      of transportation in the future.
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3 Open the front door and take out the duct.   
      Remove the foam on the air pump then take out  
      the accessory box.

4 In the accessory box are ① Wi-Fi dongle 

     ② lubricant ③ duct clamp ④ double-sided tape

     ⑤ power cord ⑥ small wrench ⑦ magnets

     ⑧ dampers ⑨ washers ⑩ nuts
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5 Front view: ① focus probe ② honeycomb   

      platform ③ level adjustment knob ④ touch  

      panel ⑤ power button 

6 Rear view: ① main switch ② power inlet ③ Ether-

net port ④ USB port ⑤ grounding cable ⑥ exhaust 

fan
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2.3 Assembly
1 Remove the release paper of the magnet and  

      stick the two magnets on the edge of the door.

2 Peel off the cover paper on both side of the  

      acrylic window and install the window with one  

      washer and one nut on each bolt.

3 Install the two dampers to the holes on the  

       edge of the machine.
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4 Plug in the power cord to the power inlet of the  

      machine and the wall socket as well. Plug in the  

      Wi-Fi dongle to the USB port on the back. Bend  

      the antenna upward for better signal.

5 Match the duct clamp to the bigger end of the 

     duct then connect it to the exhaust fan outlet.  

     Tighten the clamp using the little wrench by 

     screwing clockwise.
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2.4 Network Setup
1 Toggle the main switch on the back and press  

      the power button to turn the machine on. It takes 

      about 1 minute to start up.

2 Touch panel: Settings > Internet > Settings >  
      Select Wi-fi name > Enter password

3 The wireless IP address indicates the Internet  

      setting is done.

【【【【【【【【【【【【(p.101)
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2.5 Software Download
Download the latest version of Beam Studio from the 

download section of the FLUX official website.

https://flux3dp.com/downloads/

Windows：Download the suitable version for your 

system type. To check the system type, right click on 

the This PC icon > Properties > and find System type. 

Download the x86 version for 32-bit system and x64 

version for 64-bit system.

MacOS：Open the download file and drag the Beam 

Studio icon into the folder beside. Find and execute 

the Beam Studio in the Application folder.

Troubleshooting: Software Unexpectedly Quits (p.100)
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2.6 Software Setup
1 The language setting will pop up on the first run. 

      Select English > FLUX Beambox / Beambox Pro.

2 Fill in the machine IP address in the textbox.

3 Go to Menu > Machine or click on the camera  

      icon at the bottom left corner to check if the 

      machine name can be found. 

If the popup window was skipped previously, click 

Menu > Machine > Machine Setup 

Troubleshooting: Cannot Connect to the Machine (p.96)

Now, let's start your first engraving!
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3.1 Adjusting Focus
Engage the focus probe downward. Rotate the level 

adjustment knob to move the platform up and down. 

Make the surface of the workpiece slightly touches the 

end of the probe so the height is on the right focus. 

Retract the focus when the adjustment is done.

Check the focus before each task.

▲ Rotate the level adjustment knob

 FIRST ENGRAVING
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▲ The probe should precisely touches the surface of the material

3.2 Camera Preview
Click on  and select your machine. Start previewing 

when the cursor becomes  .Single click on a specific 

location or drag an area to preview the workarea. Click 

on  again or press ESC to leave preview mode.

▲ Click on  and select your machine.
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▲ Single click or drag an area

If the machine menu is blank when clicking on the 

camera button, it means the connection between 

the computer and the machine was not set up 

properly. Check "Cannot Connect to the Machine" 

(p.101).

3.3 Importing the Test File
Click on Menu > File > Samples > First Engraving. 

Click on Export, select your machine and click Start to 

start the task.
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▲ Import the test file

▲ Click on Start to start the task

Troubleshooting: Check the troubleshooting section if you see 

error messages (p.90)
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3.4 Engraving Result

If the result is too light or blurry, please check if the 

focus is just right. If the focus is right but the result  is 

poor, please recheck the optical path. See "Optical 

Path Adjustment" (p.60). If the position of the result 

varies with the camera preview, please recheck the fo-

cus or see "Camera Alignment Issue" (p.95).
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4.1 User Interface

     

A. Object Editing

  :  Select or move a specific object

:  Import JPG/PNG/SVG/DXF file.You can also  

         drag the file into the software

 : Font, size and spacing can be set when a text  

         object is created. Enable Infill or "Outline"

 : Set dimensions for a round object

 SOFTWARE
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 : Set dimensions for an oval object

 : Set dimensions for a polygon object

 : Create a vector curve

 :	 Copy selected objects into a rectangular array

	:	 Enable / disable camera preview

A. Object Placement

:	 Zoom in and zoom out

 :	 Group multiple items together

 :	 Ungroup items

:	 Align multiple items horizontally

:	 Align multiple items vertically

 :	 Distribute selected items horizontally between 

the left and right borders

:	 Distribute all selected items vertically between 

the top and bottom borders

      : Merge and unite multiple items into one

 :	 Subtract the overlapping area of two items

:	 Keep the overlapping area of multiple items
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C. Layer Management 

      : Create and name a new layer

      : Delete selected layer

      : Rename selected layer

 :	Sequence arrangement. 

   Working sequence will be top to bottom.

 

D. Power and Speed Setting

Parameters for commonly used material can be found 

in the "Parameters…" drop down menu. Customized 

parameters can be set using "Save". Use "Manage" 

to edit or remove saved parameters. Power is set by 

percentage which means a 40W machine can output 

40W if the power setting is 100%. Speed is set by 

mm per second. Execution count can be set to repeat 

the same action on a single layer.

Parameters may vary with different materials. Try 

built-in parameters on first run and then fine tune 

the parameters for better results.

Power setting is recommended to not exceed 70%  

to avoid drastic consumption of laser tube.
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4.2 Bitmap Engraving

Bitmap and vector are two dif ferent types of digital 

image files. Bitmap is an image type that consist of 

numerous square pixels. Bitmap files are rich in details 

which are mostly suitable for photography or digital 

applications. However, the quality is related to the 

resolution so the image can get jagged or blurry when 

resized. JPG and PNG are two commonly used bitmap 

format which are both compatible with Beam Studio.

4.2.1 Engraving Resolution

Engraving resolution can be set in Beam Studio by 

menu > "Edit" > "Document Set t ing". Engraving 

resolut ion s tands for the f ineness and quali t y of 

the final result. Get more detailed results when the 

resolution is set to "High", but it takes longer to 

engrave the same file. On the contrary, setting the 

resolution to "Low" gets rough qualit y but takes 

shor ter time. The quality stands for the spacing of 

each line scanned by the laser which correspond to 

0.2mm / 125 dpi, 0.1mm / 250 dpi and 0.05mm / 500 

dpi. Select the right resolution to fit the need of the 

quality and time.
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4.2.2 Threshold

The exposure threshold value can be set when a 

bitmap image file is imported to Beam Studio. Find 

"Shading" and "Threshold" opt ion in the "Laser 

Config" label. When "Shading" is disabled, images 

wi l l  be t rans formed into monochromic,  which is 

optimized for built- in "Monochromatic Engraving" 

parameters. When "Shading" is enabled, images will 

be transformed into greyscale, which is optimized for 

built-in "Shading Engraving" parameters.

T h e  "T h r e s h o l d"  v a l u e  c a n  b e  a d ju s te d  w h e n 

“Shading” is disabled. This func tion is based on 

the RGB color model which defines colors from 1 to 

255. 1 stands for black and 255 stands for white. For 

example, setting the threshold value to 125 will turn 

all colors above 125 into white.

4.3 Vector Engraving
A vec tor image is composed of paths defined by 

mult ip le point s .  Each path,  cur ve or  polygon is 

constructed with its own formula which means the 

quality will not be affected when resizing the image. 
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Vector images are especially suitable for logos and 

typesetting materials. Beam studio is compatible with 

SVG and DXF vector formats. 

Layers can be set to manage a complex ar twork 

when creating a vector image. Take Adobe Illustrator 

for example, the design can be organized by either 

different color groups or different layers. Beam Studio 

can import the layer setting so dif ferent engraving 

parameters can be set to each layer. Cut ting and 

engraving can be processed in the same time by this 

manner.

4.4 Bitmap and Vector Comparison

Bitmap Vector

Format JPG / PNG SVG / DXF

Usage infill engraving 
(monochrome/shading)

outline engraving/
cutting

Be sure to select vector files for cutting.
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4.5 Layer Setting
Layer ing style can be selec ted when impor ting a 

SVG file by "Layer", "Color" and "Single Layer". 

Layer: For artwork previously organized by layers in  

design software

Color: For ar twork organized by colors, the layers 

will be categorized according to its color

Single Layer: All ar twork in the file will merge into 

one single layer

4.6 Save Scene
The "Save Scene" function can save all the items 

on the scene and keep them editable. This is useful 

when the design needs some editing but most of the 

scene should remain the same. Find this function in 

Menu > File > Save Scene.
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4.7 Recommended Design Software

A u t o C A D  i s  a  C A D  s o f t w a r e  s p e c i a l i z e d  i n 

accurate dimensions, solids and more. Suitable for 

architecture and engineering applications. AutoCAD 

can expor t DXF format which is compatible with 

Beam Studio. If the dimensions do not match with 

the original design when imported, draw a 100mm 

square in Autocad then import it into Beam Studio to 

calculate the correct DPI.

Ad obe  I l l u s t r a to r  i s  a  ve c to r  g r a p h i c  d e s ig n 

sof tware which is suitable for publishing, website 

and other applications. Illustrator can expor t SVG 

format which is compatible with Beam Studio. Please 

select the SVG 1.0 format when exporting SVG files. 

Choose "Outline" for texts, "embed" for images. 

Inkscape is a free and open source vector graphic 

d e s i g n  s o f t w a r e .  I t s  f u n c t i o n s  a r e  s i m i l a r  t o 

Illustrator. Inkscape can export SVG, JPG and PNG 

format which is compatible to Beam Studio. Please 

se lec t  "p la in  SVG” format  when expor t ing SVG 

format.
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4.8 Smart Trace
The Smar t Trace can scan and trace the outline of 

simple patterns. The feature can also be found on 

our app. 

1 Prepare the file and the material. 

2 Start camera preview and capture the workarea.
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3 Press "Trace Image" and crop the area to be  

      scanned.

4 Adjust the exposure threshold value.
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5 Press "Preview" and "Apply"

6 Set the power and speed parameters and start  

      engraving.
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5.1 Testing New Materials
To test different speed and power combinations on a 

new material, import the "Material Testing Suite" from 

Menu > File > Samples.

 MATERIAL TECHNIQUE
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5.2 Wood
・Types of wood

  ・Medium-density Fiberboard (MDF)

　　    MDF i s  a  wood produc t  made by 

wood f ibers and resin binder formed under high 

temperature and pressure. The resin binder has a 

significant effect on the fume generated during laser 

process. Low formaldehyde MDF is recommended to 

reduce harmful fumes.

  ・Plywood

　　    P l y w o o d  i s  m a d e  b y  l a y e r s  o f 

wood veneer or wood f iber glued together.  Low 

formaldehyde plywood is recommended to reduce 

harmful fumes.

  ・Solid Wood

　　     Solid wood might have uneven grain 

when engraved due to growth r ings. The uneven 

density of wood can cause such result which is very 

usual.
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・Engraving results on wood

The slower the speed, the darker the engraved result. 

The higher the power, the deeper the cutting depth. 

To achieve a darker effect, slowing down the speed is 

usually more useful than raising the power.

・How To Prevent Burn Marks On Wood

Cover the surface with masking tape prior to printing, 

or remove the marks with sandpaper. The alternative 

is to slightly wet the wood, but it might cause bumps 

on the surface.

・How To Reduce Burn Edge On Wood

Clean the edges with alcohol or soapy water,  or 

choose wood with lower density, so the cutting speed 

can be faster, leaving lighter edge marks.

5.3 Leather

・Types Of Leather

Synthetic Leather

The surface of the synthetic leather is mainly divided 

into two kinds of materials: PU (polyurethane) or PVC 



43

(polyvinyl chloride). If the leather is PVC based, it is 

strongly not recommended for laser processing (see 

5.9 Dangerous Materials). When PU is not completely 

burned, hydrogen cyanide might be produced.

Genuine Leather

In general, in order to increase the thickness and 

increase the durability, the leather will be processed 

by tanning, that is, the par t of the leather which is 

similar to the non-woven material. The tanned layer 

will require a slower speed when cutting.

・How To Prevent Burn Marks On Leather

Leather gets burnt and curled easily when processed 

by laser. Soaking the entire piece of leather in water 

before processing should help.

・Ventilation Requirements for Leather

Since there are many amino groups and benzene rings 

in the leather protein composition, nitrogen oxides 

or aromatic compounds may be produced dur ing 

combustion. If the leather object is engraved or cut 

for a long time, the ventilation requirements should 
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b e  m u c h  h i g h e r  t h a n  w o o d  o r  a c r y l i c .  I t  i s 

recommended to use an air filter and discharge the air 

to a safer place.

5.4 Acrylic
・Identifying Acrylic

Acrylic is also known as PMMA or plexiglass, the 

scientific name is polymethyl methacrylate. It is one of 

the few plastics that can be processed by laser. Before 

processing, it is important to distinguish whether it 

is acrylic or other transparent plastic materials (PVC, 

PC), which are not suitable for laser processing. When 

processed on, the edges of the acrylic are sharp and 

clear. If you see yellowish burn marks, the material 

is not acrylic. However, if no burn marks are seen, it 

doesn’t prove that the material is acrylic. 

・Scratches On Acrylic

Scratches can be removed with plastic polish.
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・How To Clean Cloudy Acrylic

It is recommended that the film should remain on the 

acrylic when processing, unless engraving greyscale 

images. Use an alcohol swab to clean the acrylic, 

please note that too much may cause other sur face 

defects.

5.5 Paper
・How To Reduce Burn Edge On Paper

When cutting white paper, it is easy to produce a 

yellowish carbonized burn edge. The use of universal 

clay or other low-viscosity substances can effectively 

r e m ove  t h e  to n e r  to  a  c e r t a i n  ex te n t  w i t h o u t 

damaging the surface of the paper.

・Corrugated Cardboard

When cutting corrugated paper, the cardboard might 

catch on fire due to the misfocus on the downward 

layer.  Spray the board with water to reduce the 

chance of burning.
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5.6 Glass
Glass cracks easily, so the laser power should not be 

too powerful. Choose thick glass materials for better 

flexibility.

5.7 Metal
・Anodized Aluminum

Anodic treatment is a sur face treatment that forms 

an ox ide layer  on the a luminum a l loy.  Through 

laser  engrav ing,  the sur face ox ide layer  wi l l  be 

decomposed.

・Stainless Steel (with coating)

Due to the wavelength of CO2 lasers, stainless steel 

reflects most of the energy, so special oxidants are 

needed to allow the stainless steel to oxidize and 

darken at relatively low temperatures and darken the 

color. Wear work gloves when applying the coating.

5.8 Other Safe Materials
Stone, cement, EVA foam, cotton, linen material, etc. 
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5.9 Dangerous Materials

・PVC

PVC is  a  common mater ia l  that  cannot  be laser 

p r o c e s s e d .  W h e n  b u r n e d ,  P VC  p r o d u c e s  H C l 

(hydrochloric acid gas) that will harm the lungs and 

cor rode machine par t s .  When PVC is  burned,  i t 

also produces highly carcinogens such as dioxin or 

polychlorinated biphenyls. PVC is often presented in 

the forms of sticker, film or transparent sheet.

・ABS

ABS is  a  common mater ia l  that  cannot  be laser 

processed. ABS tends to burn “dir ty”, producing A 

(acrylonitrile), B (butadiene), and S (styrene), which are 

carcinogens category 2B, 1 and 2B.  
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・Plastics With Chlorine, Benzene, Ammonia, Fluorine, 

Phenol, Aldehyde In Its Scientific Name Or With A 

Hexagonal Benzene Ring In Its Molecular Formula 

When burning plastic molecules with these elements 

or organic s t ruc tures,  the chances of  producing 

carcinogens and toxic substances are extremely high. 

Laser processing is not recommended.

There should be no benzene ring in the       ▲ 
molecule for the material to be laser-safe.                                          
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                                               (ht tps://pse.is/KFDPQ)

Inspiration          

Pinterest Idea Board

https://pse.is/JXRR5

Use "laser engraving" as keyword on Pinterest for more 

ideas!

 

Ponoko 150 Laser Engraving Ideas 

https://pse.is/HQARL

Vector Files
The Noun Projects 

https://thenounproject.com/

Freepik 

http://freepik.com/

 PROJECT IDEAS
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Cutting Files 
DXF Projects  

https://dxfprojects.com/

Canon Creative Park 

http://cp.c-ij.com/sc/index.html

Paper-replika 

http://paper-replika.com/

Free Fonts
Dafont  

https://www.dafont.com/

Notes: To find conjoined words, check the category 

of calligraphy.
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7.1 Touch Panel – Maintenance Mode 

                                                          :	Front door opened

     :	Front door closed     

              :	Water not flowing

               :	Water flowing

     :	Water temperature

     :	X-axis limit triggered

     :	X-axis limit switch  

          not triggered

     : Y-axis limit triggered

     :	Y-axis limit switch   

          not triggered  

 

 MAINTENANCE
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7.2 Keep Everything Lubricated
Cleaning and lubricating the guiding rods and rail 

periodically can extend the lifetime of the moving 

parts. The frequency recommended is once every 1 - 

2 weeks.

1 Wipe away the oil grease on the guiding rods and 

rail using a paper towel.

2 Apply lubricant on the guiding rods of the Y-axis.

3 Apply lubricant on the top and the side of the 

linear rail of the X axis.

4 Move the laser head up-and-down, left-and-right  

several times to evenly distribute the lubricant.
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7.3 Cleaning the Work Area
1 Move the laser head to the top-left corner. Lift  

the honeycomb tray by the handles on both sides 

then take it out.

Mind the sharpness of the honeycomb sur face to 

avoid cutting injury when taking it out.

 

2  Use vacuum cleaner or brush to clear the lef t-

overs bits under the tray. Detergent can be applied to 

remove the stains.

3 Return the tray to the original location, sliding it in 

horizontally. Be careful not to contact the laser head 

or the rails. 
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7.4 Wiping the Lens
If wood and paper are used frequently, the lens and 

mirrors can get dirty ina short period of time. Clean 

them with a wet Q-tip. Alcohol can be applied if the 

stain is tough. Do not rub the mirrors too fiercely to 

prevent damaging the coating on the mirrors. The 

cleaning frequency recommended is once every 1 – 2 

weeks. 



55

 

The focus lens is inside the lens holder which are 

located under the third reflecting mirror. Lower down 

the platform or remove it out of the machine to make 

room for later procedure. Rotate the lens holder ring 

clockwise to release and remove the lens holder.
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 ▲ Release and remove the lens holder.

Rotate the silver r ing on the lens holder counter-

clockwise to take out the focus lens. Use pliers if the 

ring is too tight to rotate.

 

When putting back the lens, the curved side should 

face up and the flat side should face down.
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7.5 Water Cooler Maintenance
It is recommended that the water should be changed 

once every 3 months. 

1 Remove the screw on the handle of the back lid 

and open the lid. If you're only adding water, skip to 

step 4 after opening the lid. 

2 Remove the hose clamp with pliers and pull apart 

the hose from the white connector of the flow sensor. 

Place the two ends of the hose into a container to 

prevent water from spilling out.



58

▲ Remove the hose clamp with pliers and pull apart 

the hose

3 Blow air into one end of the water pipe so the 

water will come out of the other end.

4 Open the water tank and fill in cooling water using 

a funnel. Seal the tank when finished.

▲	Open the water tank by the small wrench
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▲ F i l l  u p  t h e  t a n k  u s i n g  a  f u n n e l .  Wa t c h  t h e 

water level carefully to prevent from spilling over 

Watch the water level carefully to prevent from spilling 

over. Distilled water is strongly recommended.

5 Restart the machine. Touch Panel > Maintenance  
> Pump. The water in the tank will be pushed into 

the cooling system. Repeat step 4 and 5 until the 

water level of the tank no longer goes down.

Too many bubbles s t icking in the laser tube may 

decrease the cooling efficiency. It is recommended to 

fill the water tank more than 80% to decrease bubble 

generation.
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7.6 Optical Path Adjustment
If the workpiece cannot be cut through by the preset 

parameters or the power output seems to vary a lot 

on each corner of the working area, the optical path 

might have got misaligned and need readjustment. 

Please yry the steps below.

Tools

Accessory Box: ② little wrench ③ double-sided tape

Prepare On Your Own:① 2.5mm Allen key

1  When pressing "Laser Pulse", please keep the 

door shut so the laser will not be disabled by the door 

interlock protection.

2 If you hear a loud cracking sound, stop operating 

and shut down the power immediately. Contact FLUX 

Support. 
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3 Remove the screw on the handle of the back lid 

and open the lid to access the laser tube.

There are three sets of reflecting mirrors and one set 

of focusing lens in Beambox.

The first reflecting mirror is located on the left side of 

the laser tube when facing the front of the machine.

The second reflecting mirror is located on the carriage 

of the guiding rod on the left side when facing the 

front of the machine.

The third reflecting mirror is located on the rail of the 

X-axis.

The focusing lens are located inside the lens holder 

beneath the third mirror.

First Reflecting Mirror

Second Reflecting 
Mirror

Third Reflecting Mirror

Focusing Lens

Top-left

Mid-left

Bottom-left

Top-right

Mid-right

Bottom-right
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7.6.1 First Reflecting Mirror

Goal: Make the 2 dots shot from 

the top-left and the bottom-left 

corner overlap.

Directions:

1 Go to Touch Panel > Maintenance and wait for 

the laser head to go back to home position. Then 

press "Release Motors".

2  Put  a  p iece  o f  doub le - s ided t ape  over  t he 

second reflecting mirror. 

3  Move the laser  head to  the top - le f t  cor ner 

manually. Close the door and press "Laser Pulse". 
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4 Open the door and check the location of the dot. 

This dot shot from the top-left corner is the reference 

point when adjusting the mirror. The shot made from 

other locations should be adjusted to move toward 

the reference point.

5 Move the laser head to the bottom-left corner.

6 Close the door and press "Laser Pulse".

7 Open the door and check if the second beam is 

overlapping with the first one. If not, adjust the screws 

behind the first mirror.
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If the dot shot from the bot tom lef t corner is not 

found on the tape, it means the optical path is very 

much misaligned. Please try the mid-left spot instead 

of the bottom-left corner. Make sure the dots of the 

top-left and the middle-left overlaps, then go back to 

the original top-left and bottom-left adjustment.

8  The screws behind the f irs t mirror control the 

mirror angle which is shown in the pic ture below. 

Release the nut on the screw, rotate the screw for the 

desired direction and test the dot location until the 

two dots overlaps. Tighten the nut slightly back to its 

position after the adjustment is done.

反射鏡 光點
     First Mirror     Dot Direction
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Adjustment guide for the screws of the mirror:

Shots made on the reference point (top-left in this case) 

rarely moves when adjusting the screws. So we try to 

adjust the shot on the adjustable point (bottom-left in 

this case) by the screws and move the point toward the 

reference point until they overlap.

7.6.2 Second Reflecting Mirror

Goal: Make the 2 dots shot from 

the middle-left and the middle-right 

overlap.

Directions:

1 Take a piece of tape and put it on the metal ring 

in front of the third mirror.
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2  M ove  t h e  l a s e r  h e a d  t o  t h e  m i d - l e f t  s p o t 

manually. Close the door and press "Laser Pulse".

3  Open the door and check the location of the 

dot. This dot shot from the middle-left corner is the 

reference point when adjusting the mirror. The shot 

made on other locations should be adjusted to move 

toward the reference point.

4 Move the laser head to the middle-r ight spot 

manually. Close the door and press "Laser Pulse".

5 Open the door and check if the second dot is 

overlapping with the first one on the same position. If 

not, adjust the screws behind the second mirror.
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If the dot shot from the middle-right corner is not 

found on the tape, it means the optical path is very 

much misaligned. Please try the middle-middle spot 

instead of the middle-right spot. Make sure the shots 

of the middle-left and the middle-middle can overlap 

and then go back to the or iginal middle- lef t and 

middle-right adjustment.
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6 The screws behind the second mirror control the 

mirror angle which is shown in the pic ture below. 

Release the nut on the screw, rotate the screw for the 

desired direction and test the shot position until the 

two shots can overlap. Tighten the nut slightly back to 

its position when the adjustment is done.

7 Put on a new tape and run the test again.

            Second Mirror            Dot Direction
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7.6.3 Laser Head Displacement Adjustment

Goal: The dot on the metal ring be 

on the vertical center line of the ring. 

The dot must be above the center 

point of the ring.

Directions:

1 Move the laser head to the center of the working 

area manually. Close the door and press "Laser Pulse".

2 Check if the dot landed on the vertical center line 

of the ring. If yes, skip to step 6.

3 Release the 4 hex socket head screws by a 2.5 mm 

Allen key.

4 Move the laser head forward or backward related 

to the rail. Then tighten the 4 screws back.

5 Press "Laser Pulse" and check if the dot landed 

on the vertical center line of the ring. If not, please 

repeat the adjustment of step  3 and 4.

6 Check if the dot overlaps or is above the horizontal 

center line of the ring. If yes, move on to "Third Mirror 

Adjustment".
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▲ above horizontal center            ▲ below horizontal center

7 If the height is below the center line, adjust the 

screws of the laser tube holder. Release the holder on 

the laser beam outlet side and tighten the other side.

                    ▲ Tighten                     ▲ Loosen

8 Check i f  the dot over laps or lands above the 

center line. The first and second mirrors might require 

readjustments if the position of the laser tube holder 

is adjusted a lot.
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7.6.4 Third Reflecting Mirror

Goal: Dot be made on the center of the laser beam 

outlet.

Directions:

1 Lower down the working platform to make room 

for adjustments.

2 Place a piece of tape on the laser head outlet. 

Apply pressure on the tape by hand so a circular mark 

can be seen.

3 Move the laser head to the center of the working 

area manually. Close the door and press "Laser Pulse".
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4 Open the door and check if the dot is located near 

the center of the circle. If not, the screws behind the 

third mirror need to be adjusted.

5 The screws behind the third mirror control the 

mirror angle which is shown in the picture below. 

Release the nut on the screws, rotate the screws 

for the desired direction until the two dots overlap. 

Tighten the nut slightly back to its position when the 

adjustment is done.

反射鏡 光點    Third Mirror      Dot Direction
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The power of the laser can be distr ibuted evenly 

to  any  lo c a t ion  on  t he  wor k ing  a rea  a f te r  t he 

adjustments above. The per formance should meet 

the needs of regular operation. Please run "Camera 

Calibration" again after the optical adjustment. If the 

verticality of the optical path is required in specific 

applications, the steps below can be carried out for 

advanced adjustments.

7.6.5 Verticality of the Optical Path (Advanced 

Adjustment)

Goal: Both dots on the lens holder and the laser 

beam outlet be on the center of the circle.

Directions:

1 Move the laser head to the center of working area 

manually. Place a piece of tape on the metal ring in 

front of the third reflecting mirror.

2 Close the door and press "Laser Pulse".
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3 Open the door and measure the distance between 

the center of the dot and the center of the ring. Let 

the distance be X.

4 Release three nuts behind the third mirror. Rotate 

the three screw equally so the mirror can move for-

ward or backward in a paralleled direction. The gap 

between the metal pieces should be X mm.
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5 Release the lens holder ring by rotating clockwise 

and lower the lens holder midway. Fasten the holder 

at the position by rotating the ring counter-clockwise.

6 Place a piece of tape on the beam outlet.

7 Refer to the steps of "Third Reflecting Mirror" and 

readjust the screws behind the third mirror so the dot 

is located at the center of the circle.

8 Release and remove the whole lens holder. Place 

a piece of tape on the location shown in the picture 

below. Apply pressure to make a circular mark on the 

tape.
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9 Close the door and press "Laser Pulse". Open the 

door and check the dot on the tape. There are three 

possibilities for the location of the shot:

  a  The shot is in the center of the circle. 

Indicating the optical path is already vertical and the 

adjustment is done.

 b The dot is on the right side of the circle.

Ind icat ing the opt ica l  path  has  an angle  which 

comes from the top-right and exit to the bottom-

lef t .  Release al l  three screws counter- c lock wise 

half a turn to decrease the gap distance between 

the metal pieces. Redo step 5 - 9.

 c The dot is on the lef t side of the circle.

Indicating the optical path has an angle which comes 

from the top-left and exit to the bottom-right. Tighten 

all three screws clockwise half a turn to increase the 

gap distance between the metal pieces. Redo step 5 

- 9.

Please run the "Camera Calibration" again after the 

adjustment is done.
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7.7 Laser Tube Replacement

Tools

 

Accessory Box: ② little wrench  ⑧ funnel 

Laser Tube Box: ⑥ laser tube hose plug➇ ⑦➇ cable ties 

Prepare On Your Own: ① water container ③ Philips 

screw driver ④ needle-nose pliers ⑤ diagonal pliers  

⑨ towel

 Please unplug power before operation.
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1 Remove the screw inside the handle of the back 

lid then open the lid.

      

There are two ends on a laser tube. The one with the 

red wire which is closer to the touch screen is called 

the high-voltage side. The other next to the f irs t 

mirror is called the low voltage side.

       ▲ High-voltage           Low-Voltage▲ 
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2 Find the white connector on the high-voltage side. 

Twist open the connector and disconnect it.

3 Find the white terminal near the low-voltage side. 

Press the button on the white terminal to release and 

remove the cable connected to the low voltage side.



80

4 Remove the screws of the laser tube holder on 

both sides.

5 Move the hose clamp away from the laser tube by 

pliers. Take the laser tube out of the chassis and place 

the low-voltage side above a container. Disconnect 

the hose from the tube and drain thebwater. Clog the 

hose by a plug when done.
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▲ Place the low-voltage end above a container.

▲ Pull off the hose and drain the tube

6 Place a towel under the high-voltage side. Cut 

the cable tie on the end of the hose with diagonal 

pliers or scissors. Pull off the hose so the tube is fully 

disconnected and can be entirely removed.
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▲ Place a towel under the high voltage side.

▲ Cut the cable tie on the end of the hose.
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▲ Pull off the hose and clog the end

Avoid spilling water into the machine. If it happens, 

wipe away the moisture and wait til l the machine 

entirely dries up.

▲ The laser tube can be entirely removed
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7 Place the new laser tube and connect the hoses 

on both ends. Zip the high-voltage end by a cable tie 

and clamp the other end using the original metal hose 

clamp.

▲ Place the new laser tube and connect the hoses

▲ Zip the high-voltage end by a cable tie
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▲ Use the original metal hose clamp to secure the 

low-voltage end

Re l e a s e  t h e  m e t a l  c l a m p  s l ow l y  to  p r eve n t 

damaging the tube by the force bounced back.

8 Reconnec t the white connec tor on the high-

voltage side. Plug the wire into the terminal on the 

low-voltage side and make sure the wire is clamped 

firmly and does not fall out. 
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▲ Reconnect the connector on the high-voltage side

▲ Check if the wire is firmly clamped by the terminal
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9 Place the laser tube into the chassis. Make sure 

the gap is wider than a finger on both ends of the 

tube. The terminal on the laser tube which connected 

to the thick red wire should point upward. Install the 

screws of the tube holder clip and make sure the tube 

is fastened firmly.

Make sure the terminal  of the red cable points 

upward instead of other angles. Do not let the end of 

the tube touch or near the side of the chassis. Wrong 

placement for the tube may cause voltage leak.
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⓾ Check all the installation and the machine is ready 

to start up.  

Do not touch the area near the high voltage side on 

the tube to prevent electric shock.

⓫ Press "Maintenance" and the laser head will go to 

home position. Press "Pump" and the cooling water 

will be pumped into the laser tube.

Beware not to press "Laser". Do not put your fingers 

near the laser beam outlet.

⓬ Unplug power and open the cap of the water tank. 

Fill the tank with a funnel and seal it back.

Watch the water level careful ly to prevent from 

spilling over. Distilled water is best recommended. 
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▲ Use a coin or the little wrench to open the tank.

▲	Pour the water into the funnel

⓭  Repeat s tep ⓫ and ⓬  unti l  the level of the 

tank no longer goes down. Then the replacement is 

complete.
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8.1 No Laser Beam Output
If there is no laser output when Beambox is running 

and the machine is making a loud cracking sound, it 

indicates the tube is broken. Please stop operating 

the machine to prevent further hardware failure. 

If you do not hear the cracking sound, please check 

the following: 

1  Open the  back  l id ,  re fe r  to  7.7  L ase r  Tube 
Replacement (p.77) for instructions. 

2 Go to touch panel > Maintenance,  make sure 

power is set to "x1.0" then close the front door. Press 

“Laser Pulse” and observe if a pinkish f luorescent 

light is emitted through the laser tube. If yes, it means 

the laser tube is functioning, please check the optical 

path. I f  no pinkish f luorescent l ight is obser ved, 

please contact FLUX Support. 

 TROUBLESHOOTING
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8.2 Cut Didn’t Go Through Material
1  Go to touch panel > Maintenance,  make sure 

power is set to "x1.0". 

2 Check if the focus is adjusted at the right height. 

3 Check if the lens or mirrors are dirty or damaged.

4 Check if the optical path is aligned. 

5 If the solutions above didn’t work, please contact 

FLUX Support.

8.3 #900 Cooler Off
1 Press "Continue", if the error message does not 

pop up again within one minute, the machine should 

operate normally. 

2 Please check if the water level of the cooling tank 

is at least half full. 
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3 If the error message pops up again, please refer 

to Water Cooler Maintenance (p.57),  change the 

water and try again.

4 If the solution didn’t work, contact FLUX Support.

8.4 #901 Door Opened
1 Go to touch panel > Maintenance, make sure if 

the door icon is changed to “closed” when the door is 

closed. If the icon is changed from "open" to "close", 

the machine should operate normally.

                

                    Door open                       Door close    

2 If the icon didn’t change, please check if the door 

magnet fell off.

3 I f  the magnet is in place, please place a new 

magnet over the front door sensor, and check if the 

icon changed. 

4 If the solution didn’t work, contact FLUX Support.
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8.5 #902 Overheated
1 Please check if the room temperature is 5℃ - 35℃  

(41°F - 95°F).

2 Go to touch panel > Maintenance and check if the 

temperature is 5℃ - 35℃ (41°F - 95°F).

3  If there is a huge dif ference between the room 

temperature and the temperature shown on the touch 

panel, please contact FLUX Support.
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8.6 The Laser Head Doesn’t Return 
To Rear Left Corner
1 Gently move the laser head to the center of the  

      bed. 

2 Go to touch panel > Action, the laser head should 

firstly move to the top and then move to the rear left. 

3 If the laser head doesn’t return to the rear lef t 

corner, please use your phone or camera to make a 

video including the whole work area.

4 Start filming and repeat step 1 and 2 and send 

the video to FLUX Support. 
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8.7 Camera Alignment Issue
1 Run camera calibration in software: Beam Studio 
> Menu > Machines > Choose Machine > Calibrate 

Camera. Make sure the height of the laser head is 

adjusted to the right focus.

2 Compare the red-dot ted- line square with the 

actual square engraved, manually adjust values to 

make the 2 squares overlapping.

8.8 Camera Preview Speed Too Slow
The preview results are formed by multiple snapshots 

put  together,  i f  the loading speed i s  too s low, 

improving the internet connection might help.

1 Go to software: Menu > Machines > Test Network 
Settings.

2 Fill in the Target device IP Address column with  

the machine IP address.

3 Press Start and the test will start running. 

4 If the average response time is over 100ms, try 

reducing the dis tance between the machine and 

the router or mobile hotspot, or change to a wired 

connection. 
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8.9 Camera Preview Doesn’t Work
If camera preview can’t be activated, please try the 

following: 

1 Restart the machine and press Action and wait for 

the laser head to go to home position.

2 Use the arrow keys or manually move the laser 

head to the center of the bed. 

3 Press Snapshot, if the image is shown, it means 

the camera is functioning. Please refer to 9.8 Camera 

Preview Speed Is Too Slow (p.95).

4 If you see a question mark icon, it means the 

camera is  not  func t ioning.  Please contac t  FLUX 

Support. 

8.10 Connection Issue
8.10.1 No Wi-Fi Found

1 Make sure the Wi-Fi dongle is fully plugged in.

2 If you don’t see the MAC Address of wireless 

network on the touch panel, please contact FLUX 

Support. 

3 The Wi-Fi channel should be 2.4Ghz (5Ghz is not 

supported).
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8.10.2 Unable to Connect When Selecting Wi-Fi

1 The Wi-Fi encryption mode should be WPA2 or no 

password.

2 The encr yption mode can be set in the Wi-Fi 

router administration interface. If the router doesn’t 

suppor t WPA2 and you need help picking out the 

right router, please contact FLUX Support. 

8.10.3 Machine Doesn’t Appear In The Software

1 Go to touch panel:  Set t ings > Internet  and 

confirm the machine IP address. If the IP address 

starts with 169.154, please see IP Address Starts With  

169.154 (p.100).

2  G o  t o  s o f t w a r e :  M e n u  >  B e a m  S t u d i o  > 

Preferences,  and f i l l  out the Machine IP Address 

column. 
3 If the machine doesn’t appear, please see Confirm 
Connection (p.98).
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8.10.4 Confirm Connection

Make sure the machine IP address is  shown and 

doesn’t start with 169.154. 

1 Go to software: Menu > Machines > Test Network 

Settings.

2 Fill in the Target device IP Address column with 

the machine IP address.
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3 Press Start and the test will start running.

4 The statistics include Network Healthiness and Av-

erage Response Time. The values should be Network 

Healthiness > 95%, Average Response Time < 100ms. 

If the machine IP address is keyed in, but the machine 

is still not found, please update the software to the 

latest version. If the connection issue persists, please 

contact FLUX Support.
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IP Address Starts With 169.154

1 If the IP address starts with 169.154, it should be a 

DHCP setting issue, please contact your ISP (internet 

service provider) for further assistance.

2 If your computer connects to the internet directly 

using PPPoE, please change to using the router to 

connect using PPPoE, and enable DHCP feature in the 

router. 

8.11 Software Quits Unexpectedly 
Windows

Please install Visual C++ Redistributable 2015, if the 

latest version is installed, please download the latest 

Visual C++ Redistr ibutable 2015 - 2019. If you are 

using Windows 7, please update to Windows 7 SP1, 

install the latest graphics driver and Windows Update 

KB2670838.

MacOS

Please update your OS to macOS 10.14 (Mojave) or 

above. Previous OS versions might have compatibility 

issues.
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Linux

Due to numerous types of systems, please provide the 

software log to FLUX Support. 
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Please read the instructions carefully before you use 

Beambox. Improper use is not cover by the insurance.

• Do not leave the machine running unattended. If 

you would like to leave temporarily, please press 

pause on the panel.

• Always operate this product from a power source 

of the same voltage. Do not operate the product 

with a damaged plug or cord.

• Be sure to disconnect the power and remove the 

power cord from the electrical supply when clean-

ing, maintaining, and servicing the laser equip-

ment.

• Beambox is not intended for use by persons (in-

cluding children) with reduced physical, senso-

ry, mental capabilities or lack of experience and 

knowledge, unless they have been given supervi-

sion or instructions concerning use of the appli-

ance by a person responsible for their safety.

• Children should be supervised to ensure that they 

 TERMS OF USE
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do not play with the appliance.

• Please place Beambox on an even surface.

• Please use Beambox in a well ventilated place. 

Fumes and smoke generated during the engraving 

process should be extracted from the room. 

• This product should not be used in the immedi-

ate vicinity of water, such as bathtubs, washbowls, 

swimming pools etc. where the likelihood of im-

mersion or splashing could occur.

• Do not stare at the bright and intense light ap-

pearing during the engraving process. Also we 

recommend not to stare at the light even through 

optical instruments. Doing so can cause serious 

eye damage, even permanent blindness.

• Operators should keep a fire extinguisher at the 

facility since laser may lead to an unexpected fire 

outbreak.

• Do not move or lift the system alone. Always seek 

assistance of one or two other people, in case you 

need to change the system’s position. The weight 

of the system may lead to injury. 


